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About this Manual
The UBC Psychiatry IT team provides support to over 150 University-owned 
computers and their users on the Psychiatry network. This manual is intended 
to provide additional information and instructions to users when Psychiatry IT 
assistance is not required or unavailable (ie. outside of regular office hours). 

Requesting Psychiatry IT Support
If you need Psychiatry IT assistance, please submit a request to  
psychiatry.it@ubc.ca or call 604-827-5695 with the following information:

• Your name and contact information

• Asset number of your computer (bottom of laptops and notebooks)

• A detailed description of the issue, and if possible, a screenshot of
any error messages

• How this issue is impacting your work

Submit your Help Request anytime to get your request into the queue, 
and the Psychiatry IT team will get back you as soon as possible to assist 
in resolving the issue during service hours from Monday to Friday from 
7:30am to 5:00pm.

If you do not require Psychiatry IT assistance, please use this manual for 
instructions, DIY troubleshooting and other helpful information on a wide 
range of tasks.

UBC Psychiatry IT Administration Team

Colin Bryant, Computer and Communications Systems Manager
Office Line: 604-822-7374
Email: colin.bryant@ubc.ca

Allan Kwan, Information Systems Specialist
Office Line: 604-827-5695
Email: allan.kwan@ubc.ca

2

https://psychiatry.ubc.ca/administration/psychiatry-it-support/
mailto:psychiatry.it@ubc.ca


TABLE OF CONTENTS
I. SETTING UP & SECURING YOUR WORK STATION    ......................................... 5

i)  UBC PSYCHIATRY COMPUTER ACCOUNT  ........................................................................................ 5
REQUESTING AN ACCOUNT  ............................................................................................................ 5
SETTING UP YOUR  PASSPHRASE    .................................................................................................. 5
PASSPHRASE SECURITY..................................................................................................................... 6
LOGGING ON AND OFF  ..................................................................................................................... 6
CHANGING YOUR PASSPHRASE     .................................................................................................... 7
LOCKED OUT OF ACCOUNT   ............................................................................................................ 7

ii)  CONNECTING TO A NETWORK  .......................................................................................................... 7

iii) REMOTE ACCESS TO YOUR DESKTOP COMPUTER      ...................................................................... 8
SETTING UP VPN FOR YOUR REMOTE WORK STATION       ......................................................... 8
PREPARATION AT THE OFFICE     ........................................................................................................ 8
CHANGING YOUR LOGON PASSWORD REMOTELY      ................................................................. 9
USING MULTIPLE MONITORS AT HOME         ..................................................................................... 9

iv) PRIVACY AND SECURITY    ...................................................................................................................... 9
CREATING A SECURE PASSWORD     .................................................................................................. 9
PATIENT RECORDS     .............................................................................................................................. 9
SECURITY UPDATES      ........................................................................................................................... 10

II. UBC EMAIL (FASMAIL)........................................................................................ 11

i)   USING YOUR FASMAIL ACCOUNT      ..................................................................................................... 11
SETTING UP & ACCESSING FASMAIL     ............................................................................................. 11
EMAIL ALIASES       .................................................................................................................................... 11
SHARING YOUR FASMAIL CALENDAR       .......................................................................................... 12
OUTLOOK LOGIN ISSUES       .................................................................................................................. 12

ii)  DEALING WITH A FULL INBOX     ............................................................................................................ 13
DELETING LARGE EMAILS     ................................................................................................................. 13
ARCHIVING EMAILS AS AN OUTLOOK DATA FILE        .................................................................... 13
ADDRESSING SPAM      ............................................................................................................................ 14
SAVING EMAILS AS FILES       .................................................................................................................. 15
PURCHASING MORE STORAGE       ....................................................................................................... 15 

iii)  GENERIC EMAIL ACCOUNTS      ............................................................................................................... 16
ACCESSING A GENERIC EMAIL ACCOUNT      ................................................................................... 16

iv)  EMAIL SECURITY    ..................................................................................................................................... 17
FRAUDULENT / PHISHING EMAILS       ................................................................................................ 17
REMOVING FASMAIL FROM A LOST DEVICE         .............................................................................. 17  
THIRD PARTY EMAIL SERVICES       ....................................................................................................... 17  

3



III. FILE STORAGE & SHARING      .............................................................................. 18

i)   PROTECTING CONFIDENTIAL INFORMATION      ............................................................................... 18

ii)  DEPARTMENT FILE SERVER         ................................................................................................................. 18
NETWORKED DRIVES I: TO Z:         ......................................................................................................... 18  
BACKUP SYSTEM & RESTORING FILES       .......................................................................................... 19

iii) UBC SUPPORTED STORAGE & SHARING      .......................................................................................... 20

IV. COMPUTERS & OTHER EQUIPMENT/FACILTIIES    .......................................... 21

i)   GUIDELINES FOR PURCHASING COMPUTERS        ................................................................................ 21
BENEFITS OF PURCHASING THROUGH PSYCHIATRY IT    ........................................................... 21
NON-STANDARDIZED COMPUTER PURCHASES     ........................................................................ 21
SELF-SUPPORTED UBC-OWNED COMPUTER PURCHASES    ...................................................... 21

ii)  SUPPORTED COMPUTER BACKUP    ...................................................................................................... 21

iii)  LAPTOPS (LENOVO THINKPAD)        ........................................................................................................ 22
TURNING ON WI-FI      ............................................................................................................................. 22
UBC WI-FI ACCESS         .............................................................................................................................. 22 
LAPTOP BATTERY FAQS       ..................................................................................................................... 22

iv)  BOOKING LAPTOPS, AV EQUIPMENT & ROOMS      ........................................................................... 23

V. SOFTWARE    ............................................................................................................ 24

VI. USER GUIDES & OTHER RESOURCES   ............................................................... 25

4



I. SETTING UP & SECURING YOUR WORK STATION

i) UBC PSYCHIATRY COMPUTER ACCOUNT
Requesting an Account

If you would like a new UBC Psychiatry accounts created, or and existing one changed 
or deleted, please first obtain approval from Psychiatry Human Resources, then let 
Psychiatry IT know as soon as possible. Accounts are modified every Friday, in batches. 
An hourly service charge will apply for account modifications requested at other times.

For new accounts, we require:

• Full name & CWL username
• UBC e-mail and work phone number
• Position/title
• Confirmation that account is for computer logon only, or requires access to 

files on a UBC Psychiatry file server; please identify which file server(s)
• Termination date (if applicable)

An account holder is responsible for all activities that originate from their account. 

Setting Up Your Passphrase

Choose a phrase that no one else can figure out, but is easy to remember and type. 
Since there’s effectively no limit on its length, it may be easier to think up a phrase you 
can remember, with some extra numbers or symbols.

Your passphrase must:

• Be changed every 185 days (6 months), or it will expire
• Be more than one word, contain a minimum of 8 to 10 characters, and contain 

at least 3 of the 4 categories -- numbers, symbols, upper-case, lower-case

Your passphrase should not:

• Contain your ID or anyone’s name, forward or reversed

• Contain any string of characters associated with you (ie. license plate, phone 
number etc.)

• Contain your ID or anyone’s name, forward or reversed
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Your passphrase should not (continued):

• Re-use the last few passwords

• Contain any string of characters associated with you (ie. license plate, phone 
number etc.)

• Be something that you can see while sitting at your desk

• Be changed more than once every 24 hours

Passphrase Security

Don’t use the “remember password” or “keychain” feature of some programs. They 
have the potential to give anyone who has access to your office, access not only your 
data but your work-group’s data.

You may occasionally receive  “phishing” emails masquerading as IT Administrators, 
often originating from a non-UBC email address. 

Under no circumstances should you share your account or password with anyone, 
unless directly and specifically requested by the Psychiatry IT team. Do NOT post 
your password on or near workstation areas. 

Remember, if people can figure out your passphrase, they will be able to see, modify 
or delete any files that you have access to. Treat your passphrase  like your ATM PIN.

You are responsible for the use of your account, and it should not be used by anyone 
other than yourself. 

Logging On and Off

Press Ctrl+ Alt + Delete, check that your user name is correct, enter your password, 
then press the Enter key. If it’s not your user name, click the “Switch User” or “Other 
User” button, then enter your user name (last name and first initial as one word, ie. 
BryantC or KwanA) and password. If it doesn’t say “Logon to: D_Psychiatry”, just 
below, you may need to enter your fully qualified user name, which is username@
psychiatry.ubc.ca.

To log off, click the “Windows” icon (bottom left), click the “Power” and select 
“Disconnect” “Sleep” “Shut down” or “Restart.” 

To protect our files from being accessed by visitors to your office, please always log 
off when you leave your work area. Unless you have scheduled maintenance work with 
Psychiatry IT staff, please shut down or restart your computer at least twice per month.
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Changing Your Passphrase

Your password can only be changed a maximum of once per 24 hours and must be 
changed at least every 185 days (6 months).

Provided you are connected to the Psychiatry network, you will get a two week 
reminder of password expiry, when you logon. Earlier reminders are available, by 
request:

1. After logging on, press Ctrl+Alt+Del simultaneously and select “Change 
Password” from the popup window. To change your computer password, on an 
office computer that you are remotely connected to, use the Ctrl-Alt-End key 
combination.

2. Enter your current password, tab to the next entry box, enter your new password, 
tab, type your new password again to confirm it and press enter to save it. Note: 
Don’t press the Enter key until all three password boxes are filled in.

Locked Out of Account

You are allowed 10 bad logon attempts (wrong password or user name) in a 20 minute 
period. If you exceed that limit, your account will be locked. 

Your account will automatically be unlocked after 45 minutes, provided you don’t keep 
trying to logon. Psychiatry IT staff can unlock your account sooner, but will need to 
verify your identity first.

ii) CONNECTING TO A NETWORK

In buildings where Department members work, desktop 
computers can be connected to a network wall jack on 
one of several virtual networks.

If would like to connect your computer to a virtual 
network, please contact Psychiatry IT with the circuit 
number. 

All jacks are labelled with a UBC circuit number (e.g 
CCT123456, see left image), because they may be 
switched to different virtual networks, but some are also 
labelled with the virtual network name. Psychiatry IT will 
tell you what virtual network the wall jack is on or will be 
able to change it for you.
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The common virtual networks are:

Psych or PSYT: Computers supported by Psychiatry IT.

IAPV2 or IAP/CWL: General UBC use. There is no access to shared departmental 
resources (e.g. P: drive or copiers). See https://it.ubc.ca/services/email-voice-
internet/internet-access-ports for usage instructions.

KOERNER2: Department member self-supported computers, that require open 
internal communication. There is no access to shared departmental resources (e.g. 
P: drive or copiers).

iii) REMOTE ACCESS TO YOUR DESKTOP COMPUTER
Department members who have a supported Windows computer on the Psychiatry 
wired network can connect to it from many other locations, and work as if they are 
sitting in front of it.  It is also possible to connect from computers on UBC networks, 
including UBC Wireless, home computers and other locations.

Note: Remote connection to UBC computers from hospital computers may not be 
possible due to hospital network security restrictions.

Setting Up VPN for Your Remote Work Station

A Virtual Private Network (VPN) connection is required for remote access to your 
Psychiatry-owned computers and network. A VPN uses encryption to protect data and 
prevent others from listening-in on the data that is transferred between your remote 
computer and the campus network.

UBC Information Technology offers free VPN services to UBC students, faculty, and 
staff at both the Vancouver and Okanagan campuses. Visit the UBC IT myVPN page 
for step-by-step instructions on how to set this up.

Preparation at the Office
1. Request approval for remote access to your office computer from your 

supervisor.

2. When in your office, note your computer’s asset number from its label and 
contact Psychiatry IT with i) your computer asset number and ii) your logon 
account name.

3. Leave your office computer running. Psychiatry IT will set it up and provide you 
with further instructions.
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Changing Your Logon Password Remotely

To change the logon password on an office computer that you are remotely connected 
to, use the Ctrl-Alt-End key combination.  Ctrl-Alt-Del only works on the computer that 
you are physically in front of.

Using Multiple Monitors at Home

If you would like to use more than one monitor at home during a remote desktop 
connection, please see this video for instructions.

iv) PRIVACY AND SECURITY
 
The UBC Privacy Matters initiative offers a wealth of information about what personal 
information we need protect and how to protect it. 

Creating a Secure Password
 
A quick web search will provide quite a bit of advice about choosing a strong password. 
Psychiatry IT often recommends using the Schneier Scheme.

Take a sentence and turn it into a password. Something like “This little piggy went 
to market” might become “tlpWENT2m”. That nine-character password won’t be in 
anyone’s dictionary. Of course, don’t use this one, because it’s here in public. Choose 
your own sentence -- something personal.

Here are some examples:

• WIw7,mstmsritt... = When I was seven, my sister threw my stuffed rabbit in 
the toilet.

• Ltime@go-inag~faaa! = Long time ago in a galaxy not far away at all.

• uTVM,TPw55:utvm,tpwstillsecure = Until this very moment, these passwords 
were still secure.

Combine a personally memorable sentence with some personally memorable tricks to 
modify that sentence into a password to create a lengthy password.

Patient Records

Your computer and networked drives (e.g. P:, M:, Y: and U:) should not store 
identifiable patient data. Although our security standard is fairly high, we may not meet 
the legal requirements for storing patient information.
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Security Updates
 
All computers must be connected to the internet, logged on and all pending updates 
accepted, at least monthly. 

If your computer is connected to our network infrequently, like some laptops are, 
please add a monthly reminder to your schedule. It may take a few computer restarts 
and acceptances of the patches before they are all completed. If you fail to do so, the 
status of your computer will become “SelfSupported” and you will no longer have 
access to P:, M: or N: drives, networked printers or our other services. 

We will not support your computer again, until it has undergone a rigorous security 
check. In the interest of energy saving and completion of these important security 
patches, we recommend that you shutdown or restart your computer weekly.

Windows/Microsoft & Other Software Updates: Our management systems will 
install Microsoft and other software updates overnight. Some updates will restart your 
computer, so please save open files before leaving
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II. UBC EMAIL (FASMAIL)

i) USING YOUR FASMAIL ACCOUNT
Setting Up & Accessing FASmail

All UBC staff and faculty are eligible for a UBC FASmail account. Upon hire, the 
Psychiatry HR team will assist new staff / full-time faculty members in setting this up. 

Clinical faculty members are also eligible for a FASmail account, which can be set up on 
a per request basis.

FASmail General Information:  Learn more about FASmail features, account holder 
eligibility, and other general information.

FASmail User Training Guides:  Learn more about FASmail features, account holder 
eligibility, and other general information.

WEBMAIL: You can log into your FASmail account from any browser via the UBC 
FASmail login portal using your CWL (Campus Wide Login) user name and password. 
The basic functions of Outlook are available through Webmail, however you cannot 
configure the sharing of your email or calendar to other FASmail users.

OUTLOOK: FASmail is accessible through Microsoft Outlook, the preferred platform at 
UBC. The Psychiatry IT team will be able to provide assistance in setting up access to 
FASmail through Outlook on your UBC-owned work computer. 

OTHER PLATFORMS & DEVICES: For setting up FASmail access on other platforms 
and devices, please see these FASmail Set Up Documents for detailed step-by-step 
instructions.

Email Aliases

The department sets up FASmail accounts with a firstname.lastname@ubc.ca primary 
email alias to make it easier for people to see who they are sending an email to.

When an email to an alias arrives at UBC, it will be redirected to your actual email 
account (Your_CWL_ID@mail.ubc.ca). The UBC Directory can be configured so 
that more than one alias (secondary aliases) can be directed to one email account. 
Typically, all mail sent from your account will appear to come from your primary alias.
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Sharing Your FASmail Calendar

You can share your FASmail User calendar with another FASmail User account holder 
(e.g. A faculty member shares their calendar so that administrative staff can update 
their schedule). You must have your FASmail user account setup in Microsoft Outlook 
to turn on sharing.

SHARING WITHIN OUTLOOK:

1. Start Outlook, logon with your CWL and view the calendar that you want to 
share, then click Calendar Permissions

2. In the “Calendar Properties” window, select the “Permission Level” that you want 
to give the other FASmail User. In the case of an assistant, “Author” is frequently 
a good choice. It allows them to read your own calendar, add items, edit or 
delete their added items. You can also manually set their Read, Write and Delete 
settings.

3. Click OK, to save and let the user you shared to know that they now have access 
to your calendar.

SHARING WITHIN WEBMAIL:

1. Browse to https://www.mail.ubc.ca and login with your FASmail/CWL account

2. Click the Calendar category on the left

3. Above your calendar, click Share, then Add Calendar...

4. In the “Add Calendar” window, enter the name of the person, who’s calendar you 
want to view and click OK. instructions.

Outlook Login Issues
1. If you are suddenly unable to login to your FASmail account, in Microsoft 

Outlook, please ensure that your username is showing as “EAD\Your_CWL_ID”

2. If it is showing your firstname.lastname@ubc.ca alias, or something else, choose 
“Use another account”

3. Enter “EAD\Your_CWL_ID”, then your CWL Password to login to Outlook. If you 
continue to have difficulty, please contact Psychiatry IT or call the UBC IT Service 
Centre at 604-822-2008.
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ii) DEALING WITH A FULL INBOX
The default (free) size of FASmail User accounts is 8GB. If you find yourself reaching 
that limit, there are several solutions.

Deleting Large Emails
1. First sort your inbox by message size by clicking on the “By Categories” column 

under right side of the Search Bar.

2. Select “Size” and click the arrow on the right to select if you would like emails to 
be listed in increasing or decreasing size values. 

3. Identify and delete any large emails you no longer need to keep. 

Archiving Emails as an Outlook Data File (.pst)

If your account is running out of space, you can archive older emails as an alternative 
to deleting them. This way, you can still search and view them on an as-needed basis.    

1. Click the Home tab, then New Items > More Items > Outlook Data File.

2. The local drive and folder will open on your computer (ie. “Outlook Files). Do 
not leave the local drive or use P: drive or any other network drive. Select or 
create an appropriate folder, name your Outlook Data File (ie. Inbox 2018), and 
click OK. 

3. Your new Outlook Data File will appear as named in the Folder Pane on the left 
(where your Inbox is situated), and will have default subfolders “Deleted Items” 
and  customizable “Search Folders,” which you can use if you like. You can also 
create additional subfolders by right-clicking and selecting “New Folders.”

4.  Select the emails you wish to archive and drag them to the Outlook Data File in 
the Folder Pane, or one of its subfolders. 

5. When all the emails you wish to archive (ie. all Inbox emails from 2018) are in 
your Outlook Data File, right-click on it and select “Close OutlookDataFile.” 
These emails will no longer be stored in your Outlook account.

6. To view your archived emails or add or move emails to/from your Outlook Data 
File, click the File tab, then in the left side panel select Open & Export > Open 
Outlook Data File, (alternatively, New Items > More Items > Outlook Data File) 
to locate then click on the Outlook Data File on the local drive. 

7. When you are done viewing or editing, close as instructed in Step 5.
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Addressing Spam

You can enable a Junk Mail Filter if you are using Outlook with cached mode enabled.

ENABLING CACHED MODE:

1. Click the “File” tab, then “Account Settings”, then “Account Settings” again.

2. Double click your account (usually only one listed) on the “E-mail” tab, before
clicking “Use Cached Exchange Mode”, “Next”, “Finish” and closing the
“Account Settings” window.

ENABLING JUNK MAIL FILTER:

1. Click Home > Junk ( in the Delete 
group) > Junk E-mail Options.

2. Set the scanning level to Low. 
This will save Junk mail into a 
Junk Mail folder on the server. 
You will have to monitor this 
folder to ensure that there are no 
false positives in it.

3. If you get more spam email, send 
it as an attachment to is-spam@ 
ubc.ca. It will be used to tune the 
UBC SPAM filter.
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Saving Emails as Files

If you use Microsoft Outlook, you can save individual emails to your computer, then 
delete them from your inbox. You can choose between these file types:

*.pdf individual - Readable by any computer. Open the email, click “File” tab, then 
click “Save as PDF,” enter a “File name” in the field, then click “Save” to your desired 
file location.  (recommended)

*.pdf bulk - Readable by any computer. Select a folder in Outlook, right-click and 
select “Convert “FolderName” to PDF,” enter a “File name” in the field, then click 
“Save” to your desired file location.  (recommended)

*.msg - Only readable with Microsoft Outlook. Select email, click “File” tab, “Save 
As,” enter a “File name” in the field, click save type as Outlook Message Format 
(*msg) to your desired file location, then click “Save.”   

*.txt - Readable by any computer, but loses all formatting. Follow instructions for 
.msg, but click save type as “Text Only.”

*.mht - Readable by any computer with Internet Edge.  Follow instructions for .msg, 
but click save type as “MHT files.”

*.htm (or *.html) - Readable by any web browser, but creates a file and a folder with 
multiple files. Follow instructions for .msg, but click save type as “HTML.”

None of these methods will remove the email from its original folders. You must delete 
the original email after using one of the above methods.

Purchasing More Storage 

If you require more storage than the default (free) size of 8GB provided to all FASmail 
user accounts, submit your request to UBC Psychiatry IT with the following details:

• CWL user name associated with your FASmail account

• Size of increase (yearly basis)

• Billing information ($1.50/GB per fiscal year)
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iii) GENERIC EMAIL ACCOUNTS
Generic mailboxes are mailboxes that are not associated with a person. They are 
typically role-based or service-based accounts that are accessed by one or more users, 
and can be setup for your UBC Psychiatry program and research projects, at no cost. 

• The default size of Generic email accounts is 4GB. Additional space is 
$1.50/GB per fiscal year.

• Having more than 5-6 generic accounts displayed in Microsoft Outlook can 
lead to performance issues.

• For access to the FASmail Generic account by non-FASmail User account 
holders (e.g. non-UBC volunteers), you will first need to create Guest CWL 
accounts for them with an expiry date.

If your team requires a shared email for a UBC Psychiatry-related research or 
collaborative project, please contact the Psychiatry HR team to request creation of a 
FASmail Generic account.

Accessing a Generic Email Account

Access to Generic Mailboxes is not available using a shared password. Instead access 
is granted to individuals using their own CWL credentials in Outlook or Webmail.

OUTLOOK: 

If the generic account Display Name (e.g. UBC-PSYT My Generic) shows in Outlook, 
your generic account may have been Automapped. To test, send an email from the 
generic account, and if it shows in the Sent folder of your individual email account, you 
will need to create a new Outlook profile. Please contact Psychiatry IT for assistance.

If the generic account shows as an alias (ie. my.generic@ubc.ca), and mail sent from 
the generic account shows in the generic account’s Sent folder, you do not need to do 
anything further. 

If you plan to use the Mail Merge feature of Microsoft Word, you may prefer to create a 
completely separate Outlook profile (please contact Psychiatry IT for instructions) for 
the Generic mailbox. When you open Outlook, you will be prompted to select a profile 
to use.

WEBMAIL:

Instructions for accessing generic email accounts using Webmail can be found here.
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iv) EMAIL SECURITY
Fraudulent / Phishing Emails

Phishing emails are attempts to get you to provide personal information by 
masquerading as a person or organization that you trust. Most attempts will arrive by 
email, but they can also be made by telephone, letter mail and in person.

The UBC mail relays remain effective in rejecting high-risk emails, but misses the odd 
one. Do not open, click on any links, or provide your CWL or any personal information 
on any emails that appear even slightly suspicious. 

Carefully read and follow the guidelines here if you have any questions or concerns 
about suspicious emails in your Inbox. 

Removing FASmail from a Lost Device

If you have your UBC FASmail on an iPhone or iPad which has been lost, you can 
remove or wipe its data from your smartphone:

1. Log in at mail.ubc.ca with your CWL account.

2. Click the Settings Wheel on the top right, select Options, then clicking Mobile
devices on the left menu list.

3. Select the device you want to wipe, then click on the Remove or Wipe all data
icon.

Third Party Email Services

Personal email accounts (Google, Hotmail, Yahoo etc.) should not be used for official 
University business (UBC Information Security Manual). Instead, your UBC account 
must be used.

Reasons for this policy include:

• The Freedom of Information and Protection of Privacy Act requires us to
protect personal information and store it in Canada.

• Commercially hosted email accounts are less secure and since emails may
contain valuable information owned by UBC there could be a heightened risk
of unauthorized disclosure.

For more information please refer to the UBC Privacy Matters website.
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III. FILE STORAGE & SHARING

i) PROTECTING CONFIDENTIAL INFORMATION
The BC Freedom of Information and Protection of Privacy Act (FoIPPA) requires 
public sector organizations, including UBC, to protect any files containing personal 
information by “making reasonable security arrangements against such risks as 
unauthorized access, collection, use, disclosure or disposal.“

As a Department, we must ensure that the appropriate security measures are observed 
for records containing personal or other confidential information. As  such, please DO 
NOT share or store sensitive information in Box, Dropbox, OneDrive (except UBC 
OneDrive), iCloud and Google Docs, or any other non-Canadian owned services, 
unless a UBC risk assessment has been completed.

The following file storage and sharing services that meet (FoIPPA) legal requirements, 
and are available to all Department staff, students, and faculty members.

ii) DEPARTMENT FILE SERVER
For Psychiatry IT supported computer users, we contract our file storage to the UBC IT 
Storage Grid and access it through a UBC EduCloud virtual server.  As such, users on 
the Psychiatry network have access to the UBC Storage Area Network. When naming 
paths and files:

• Do not use any of the following characters: ? : / * < > |

• Keep file names up to 64 characters, folder names up to 31 characters, and full 
path names to 260 characters or less. 

Failure to conform to these limits may make your files inaccessible to others or prevent 
backup/archiving of your files.

Networked Drives I: to Z:

If you use a supported Windows computer, you will see one or more networked hard 
disk drive(s) with a drive letter from I: to Z:, as well as a descriptive name to the left of 
the drive letter. If expected drives are missing, please log-off and back on for automatic 
re-connection.
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U: (“USER”) DRIVE: 

This drive is available by request. It has a private folder for each account holder. Use it 
as your main personal drive or to store backups of critical files, however keep in mind 
that you are limited to 2GB of space (unless you have purchased additional space. 
To check your usage, start the file Explorer, right click on your Directory and select 
properties from the drop down list.

P: \ALLPSYCH SHARED FOLDER: 

The “P:\AllPsych” folder contains some shared files and can also be used as a 
temporary storage area while transferring files between divisions, labs or programs.

Please delete files when you have completed transfers.

Backup System & Restoring Files
Psychiatry IT backs up files on these drives as follows: All Monday to Friday file 
changes are kept for 10 days, and archived on a monthly basis.

As an adjunct to our backup system, file changes or “shadow copies” are temporarily 
saved at 7am and 12pm each day. Given space limitations, only up to 64 copies of any 
one file are available at any given time.

RESTORING FILES: 

You can restore files from shadow copies if 
you need a previous version prior to recent 
file changes:

• Right-click the file and select
‘Properties’

• Left-click the ‘Previous Versions’ tab

It may take a few minutes for all available 
versions to appear. Click on the desired 
version and select ‘View’, ‘Copy’ or 
‘Restore’. 

Restoring older files may require 
Psychiatry IT assistance. This may take up 
to 3 days at a charge of $65/hr.
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iii) UBC SUPPORTED STORAGE & SHARING
UBC offers several options for Faculty and Staff to safely and securely store their 
electronic files. The storage solutions available to utilize are either, cloud based with 
files being stored offsite at a Canadian data center, or accessible only by the individual.

Which service you choose to use will depend on the nature of the information you are 
storing, as well as whom you may wish to share that information with. To determine 
which storage option fits your needs, please review the service descriptions below.

UBC Microsoft OneDrive
General data accessible by you and others that you provide read or write access to, 
including non-UBC users:  https://it.ubc.ca/services/web-servers-storage/microsoft-
onedrive
    
UBC Microsoft Teams
General data shared across units at UBC for collaboration purposes:  https://it.ubc.ca/
services/email-voice-internet/microsoft-teams

Home Drive
File repository for individual files only meant to be accessible by you (VPN connection 
required)

TeamShare
General and sensitive data accessible by you and your UBC colleagues (VPN 
connection required)
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IV. COMPUTERS & OTHER EQUIPMENT/FACILITIES

i) GUIDELINES FOR PURCHASING COMPUTERS
The Department has specific policies about the computers and hardware allowed on its 
computer systems. 

Benefits of Purchasing through Psychiatry IT

The Department employs standardized desktop and notebook computer models, 
allowing Psychiatry IT to provide more efficient support to large numbers of computers. 
In addition, the Department makes purchases through a preferred vendor, allowing for 
better negotiated pricing and preformatted systems that require less setup time. 

Non-standardized Computer Purchases

While we prefer that all computers are bought through Psychiatry IT, it is possible for 
non-standard computers to be added to the Department network and IT support list. 
However, you may be charged for additional preparation time, consumer warranty 
support and mandatory management software. Always consult with Psychiatry IT 
before purchasing these from other sources.

Faculty who are newly hired and arrive with their existing computer equipment 
will only be charged the management software license fee to have their existing 
computer added to the Department computer network and support list.

Self-Supported UBC-owned Computer Purchases

For self-supported computers (maintenance is up to you), you can order the computer 
yourself or we can assist you. If you order the computer yourself, you must supply 
us with a copy of the invoice showing UBC ownership before we will install UBC site 
licensed software.

ii) SUPPORTED COMPUTER BACKUP
As Psychiatry IT does not routinely backup the hard drives (typically lettered C: 
through H:) of the computers that we support. As such, we highly recommend that 
you save your files to drives I: through Z: on our servers, instead of on your computer. 
Drives I: to Z: are backed up two times a day at 7am and 12pm, and the last ten days 
of backups are stored. Backups are also done on a monthly basis and archived.  In 
addition, Psychiatry IT makes a permanent archive of server drives twice a year. 
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BACK UP SERVICES FOR HARD DRIVES: 

If you do require back up services for hard drives (C: through H:), Psychiatry IT offers 
an optional paid service to backup your computer hard drive(s), provided the computer 
is connected to the Psychiatry wired network. These backups are encrypted and they 
stay on-site, so are compliant with FoIPP regulations.  Daily file variants are saved for 
14 days. The Department provides the backup server and annual backup software 
licensing. End users will need to pay for the storage space that they use, for $0.35 per 
GB, per year. Most of our optional backup users pay less than $10.00 per year for this 
service.

If you would like to participate, please contact Psychiatry IT with the asset number of 
the computer and we will provide an estimated cost for this service.

iii) LAPTOPS (LENOVO THINKPAD)

Turning on Wi-Fi

Click Start (or the Windows button at the bottom left) > Settings > Network & 
Internet > Slide Wi-Fi On, then click Wi-Fi to see the list of available networks.

UBC Wi-Fi Access

UBC hosts several wireless networks to support students, faculty and staff on campus 
and at partner institutions:

EDUROAM is a collaborative network that provides students, staff and faculty roaming 
wireless access at partner institutions. To connect, use the same credentials as you 
would at your partner institution OR use your UBC CWL credentials as follows:

LOGIN:    Your_CWL_ID@ubc.ca (remember to add @ubc.ca) 
PASSWORD: Your_CWL_Password

UBCSECURE is available to members of the UBC community with a valid student, 
faculty, or staff CWL account. Use your usual CWL login credentials to connect. 

Laptop Battery FAQs

How should l care for a brand new laptop battery?
A brand new laptop battery must be conditioned to operate at its full capacity. 
Laptop batteries are shipped in a discharged state and must be fully charged when
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you receive your new battery. After this, it must be partially discharged and 
fully charged at least five times in order to reach its full capacity. This is done by 
unplugging the laptop from the power cord and running on battery power for 
30-60 minutes. The conditioning process should be completed within the first 
month of receiving your new battery. It is important to NOT let the brand new 
battery empty completely, as this can damage the new battery. 

How long will my laptop battery run when not connected to the power cord?
Average run time is 1.5 hours to 3.5 hours depending on what applications you are 
running. Functions that require more power will deplete your laptop battery faster. 

How can I make my laptop battery life last longer?
You can maximize your battery life by changing the amount of power your 
computer draws while in battery mode. Click Start (or the Windows button at 
the bottom left) > Settings > System >Battery. Under Battery Saver, check Turn 
battery saver on automatically if my battery falls below and then choose between 
5 and 100 percent battery life. Check also the option Lower screen brightness.  

How do I keep my laptop battery running optimally?
If your laptop is plugged in for extended periods of time, your laptop battery will be 
in lengthy “stand-by” periods which may shorten the life of the battery. Running 
on battery power for 30-60 minutes per week is sufficient to keep your battery 
in good shape. As well, never run your laptop battery all the way to empty. If a 
computer battery is discharged past the critical 3% level, the battery may not be 
able to be recharged again as this effectively kills the battery.

When should my laptop battery be replaced?
If the battery is over 2-3 years old, has been recharged 300-500 times, or the 
battery life becomes excessively  short, the battery should be replaced.

iv) BOOKING LAPTOPS, AV EQUIPMENT & ROOMS
Bookings are only processed once per work day, so please book at least 24 hours in 
advance.  Submit your requests to psyt.bookings@ubc.ca if you wish to book:

• Loaner laptops, Powerpoint projectors, portable projection screens, flip
charts, and other audio-video equipment.

•  Detwiller Rooms 1C11/12 (1 East Conference, max. ), 1C13 (Video Conference),
2C12 (2 East Conference), 2C13 (2 West Conference), 2NA/B, G859, or the
Detwiller Lecture Theatre.
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V. SOFTWARE 
Always contact Psychiatry IT before purchasing, installing or removing any software 
from your computer!

Psychiatry IT installs software and security patches, and maintains security settings 
based on our record of installed software. Generally, software is licensed for installation 
onto one computer, and you do not own the software. Some software is available 
through UBC campus licensing for computers on our network, at greatly reduced 
prices:  https://it.ubc.ca/services/desktop-print-services/software-licensing. Please 
contact Psychiatry IT for details.

Available Software

WEB BROWSERS: Psychiatry IT currently supports Firefox, Google Chrome, and Edge.

MICROSOFT OFFICE: Office 2019 is installed on all new computers, but will install 
Office 2016 by request. Your computer must be connected to the UBC network 
periodically for Office to continue working.

OTHER MICROSOFT SOFTWARE: Psychiatry IT can install Microsoft Project, Visio etc. 
for free on UBC-owned computers.

MATHEMATICAL & STATISTICAL SOFTWARE: 

•  MATLAB is available for all faculty, staff and researchers for non-commercial 
teaching and research purposes.

• SAS may be used by UBC staff, faculty, employees, and students and only for 
non-commercial Teaching and Research and/or Administrative purposes for UBC.

• SPSS Statistics is available for UBC-owned computers.

• Maple may be used on UBC-owned computers, faculty owned computers, and 
personal or office computers.

ADOBE PRODUCTS: UBC IT offers many Adobe products, including Acrobat, 
Photoshop and Illustrator. It is free for staff and faculty on UBC-owned computers.

ANTI-MALWARE: Anti-Malware solutions are available to help prevent cyber-attacks.

OTHER SOFTWARE: NVIVO is available for UBC-owned comperters and screen 
capture software (Snagit & Camtasia) are available to faculty, staff and students. 

24

https://it.ubc.ca/services/desktop-print-services/software-licensing/matlab
https://it.ubc.ca/services/desktop-print-services/software-licensing/sas
https://it.ubc.ca/services/desktop-print-services/software-licensing/spss
https://it.ubc.ca/services/desktop-print-services/software-licensing/maple
https://it.ubc.ca/services/cybersecurity-services/malware-protection
https://it.ubc.ca/services/desktop-print-services/software-licensing/nvivo-pro-software


 
VI. USER GUIDES & OTHER RESOURCES

•  Windows 10 Quick Start: Desktop at Work Guide 

• Lenovo ThinkPad Laptop Support Site and enter the model of your lap (is. 
ThinkPad T440) to find the User Guide and How To’s for helpful information and 
instructions. 

•  Printer Set up for Windows 10 & 11

• FoM Room Finder and Booking
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